


Copyright

Ce document est Copyright © 2012 par ses contributeurs tels que listés ci-dessous. Vous pouvez
le  distribuer  et/ou  le  modifier  sous  les  termes  des  licences  GNU  General  Public  License
(http://www.gnu.org/licenses/gpl.html),  version 3 ou ultérieure  ou Creative  Commons Attribution
License (http://creativecommons.org/licenses/by/3.0/), version 3 ou ultérieure.

Tous les noms de marque cités dans ce guide appartiennent à leurs propriétaires légitimes.

Contributeurs
Auteur : André Merle

Relecteurs : Philippe Clément, Laurent Balland-Poirier

Retours
Veuillez faire parvenir tout commentaire ou suggestion concernant ce document à :

doc@fr.libreoffice.org

Remerciements
Ce  chapitre  est  basé  sur  les  chapitres  8 de  OpenOffice.org  3.3  Impress  Guide  (anglais),
LibreOffice 3.6 Introducing Impress (anglais). Les contributeurs de ce chapitre sont :

Michele Zarri Jean Hollis Weber Nicole Cairns Martin J Fox
T. Elliot Turner Peter Hillier-Brook Low Song Chuan

Date de publication et version du logiciel
Publié le 1er octobre 2013. Basé sur LibreOffice 3.6.

Note pour les utilisateurs de Mac

Certaines frappes au clavier et certains menus sont différents de ceux utilisés sous Windows et
Linux. Le tableau ci-dessous donne quelques équivalences pour les instructions de ce chapitre.
Pour une liste plus détaillée, voir l’aide de l’application.

Windows ou Linux Équivalent Mac Effet

Choix de menu  Outils >
Options

LibreOffice > Préférences Accès au paramétrage des options

Clic-droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d’autres touches

F5 Majuscule+⌘+F5 Lance le diaporama

F11 ⌘+T Ouvre la fenêtre Styles et formatage

La documentation pour LibreOffice est disponible à fr.libreoffice.org

http://fr.libreoffice.org/
mailto:doc@fr.libreoffice.org
http://creativecommons.org/licenses/by/3.0/
http://www.gnu.org/licenses/gpl.html


Table des matières

Copyright........................................................................................................................................ 2

Note pour les utilisateurs de Mac.................................................................................................2

Introduction....................................................................................................................................4

Ajouter, renommer, et supprimer des diapositives.....................................................................5

Ajouter une nouvelle diapositive..................................................................................................5

Insérer une diapositive à partir d’une autre présentation.............................................................5
Insérer à partir d’un fichier......................................................................................................5
Copier et coller d’une présentation à une autre.......................................................................6
Glisser-déposer d’une présentation à une autre.....................................................................6

Dupliquer une diapositive............................................................................................................7

Renommer une diapositive..........................................................................................................7

Répartir les éléments d’une diapositive sur plusieurs autres.......................................................7

Résumer plusieurs diapositives en une seule..............................................................................8

Supprimer une diapositive...........................................................................................................9

Créer des diapositives d’après un plan........................................................................................9

Utiliser un plan créé avec Writer..................................................................................................9

Utiliser une auto-synthèse créée avec Writer............................................................................10

Copier et coller un plan..............................................................................................................11

Modifier des diapositives.............................................................................................................11

Formater la diapositive..............................................................................................................11

Choisir une page maîtresse.......................................................................................................12

Modifier l’arrière-plan d’une diapositive.....................................................................................13

Choisir une mise en page de diapositive...................................................................................13

Ajouter des commentaires..........................................................................................................14

Éditer, supprimer et répondre aux commentaires......................................................................15

Ajouter et formater des notes.....................................................................................................15

Ajouter des notes à une diapositive...........................................................................................15

Formater des notes...................................................................................................................16
Formater la page des Notes..................................................................................................17
Paramétrer la mise en page automatique.............................................................................17
Formatage du texte...............................................................................................................18
Formatage avancé du texte..................................................................................................18

Imprimer les notes.....................................................................................................................18

Exporter les notes en PDF........................................................................................................19

Créer des prospectus..................................................................................................................20

Modifier la mise en page...........................................................................................................20

Formater les prospectus............................................................................................................21
Formater la page...................................................................................................................21
Paramétrer les options de mise en page automatique..........................................................21
Déplacer les vignettes et ajouter des images........................................................................21

Imprimer les prospectus............................................................................................................22
Exporter les prospectus en PDF...........................................................................................22

LibreOffice 3.6 : Impress, guide utilisateur 3



Introduction

Attention

Toutes  les  figures  ou  représentations d’icônes  de  ce  document sont
reproduites avec une configuration de LibreOffice qui a adopté le style Tango pour
les icônes et la police système pour l’interface utilisateur.

Pour modifier le style des icônes, sélectionnez Outils > Options > LibreOffice >
Affichage et dans la section Interface utilisateur :

• choisir la taille et le style des icônes ;

• cocher la case utiliser la police système pour l’interface utilisateur ;

ainsi votre écran peut ne pas correspondre exactement aux représentations.

Ce chapitre montre comment ajouter de nouvelles diapositives à une présentation et les formater.
Il explique aussi comment formater les  Notes et les  Prospectus.  Généralement, les  Notes sont
utilisées comme prompteur par la personne qui présente et les Prospectus pour fournir une copie
imprimée de la présentation aux auditeurs.

Deux menus contextuels sont disponibles pour mener ces opérations sur les diapositives. L’un est
affiché  en  cliquant-droit  sur  une  diapositive  dans  le  mode  Normal et  en  sélectionnant  Diapo
(Figure 1). L’autre en cliquant-droit sur une vignette de diapositive dans le volet Diapos (Figure 2).

Figure 1 : Menu contextuel Diapo

Figure 2 : Menu contextuel volet Diapos
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Ajouter, renommer, et supprimer des diapositives

Ajouter une nouvelle diapositive
Vous pouvez ajouter une diapositive à une présentation de plusieurs manières :

• Dans les modes Normal, Plan, ou Trieuse de diapositives, sélectionnez Insertion > Diapo
dans le menu principal.

• Dans les modes Normal,  Plan, ou Notes, cliquez-droit sur le volet Diapos et sélectionnez
Nouvelle diapo dans le menu contextuel.

• Dans le mode  Trieuse de diapositives,  cliquez-droit  dans l’espace de travail  principal et
sélectionnez Nouvelle diapo dans le menu contextuel.

• Dans le mode Normal, cliquez-droit dans l’espace de travail principal et sélectionnez Diapo
> Nouvelle diapo dans le menu contextuel.

• Dans le mode Normal, dans la barre d’outils Présentation, cliquez sur le bouton Diapo ; le
petit triangle noir à côté du bouton, permet de choisir directement une nouvelle disposition
de la diapo.

La  nouvelle  diapositive  est  insérée  après  la  diapositive  courante  ou  à  l’endroit  du  clic.  Sa
disposition des cadres correspond à celle de la diapositive précédente.

De même,  si  plusieurs  masques de diapositive  sont  utilisés  dans la  présentation,  la  nouvelle
diapositive adoptera celui de la diapositive qui la précède.

Insérer une diapositive à partir d’une autre présentation
Vous pouvez insérer des diapositives à partir d’autres présentations de trois manières :

• En utilisant  Insertion > Fichier :  avec cette méthode, vous pouvez lier  les diapositives
plutôt  que  de les  coller.  Le  fichier  est  ainsi  incorporé  dans votre  présentation  avec la
technologie OLE. Référez-vous au Chapitre 7, Ajouter des feuilles de calcul, graphiques et
autres objets de ce guide pour de plus amples informations sur OLE.

• Copier et coller.

• Par glisser-déposer pour copier ou déplacer des diapositives.

Insérer à partir d’un fichier

Figure 3 : Insertion à partir d’un fichier

1) Dans le mode  Normal, sélectionnez la diapositive après laquelle vous voulez insérer  les
diapositives d’un autre fichier, puis choisissez Insertion > Fichier dans le menu principal.
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2) Dans  l’explorateur  de  fichiers  qui  s’ouvre,  sélectionnez  le  fichier  qui  contient  les
diapositives à insérer et cliquez sur Ouvrir.

3) La boîte de dialogue  Insérer des pages/des objets (Figure 3) s’ouvre.  Cliquez sur le
signe plus (+) à gauche du nom de fichier pour lister les diapositives qu’il contient.

4) Sélectionnez les diapositives que vous voulez insérer dans votre présentation.

5) Si besoin, sélectionnez l’option Lier pour incorporer les diapositives en tant qu’objets OLE.

6) Cliquez sur OK. Les diapositives sont insérées après la diapositive sélectionnée dans votre
présentation.

Astuce
La  Figure  3 montre  bien  l’intérêt de  donner  un  nom  aux  diapositives  d’une
présentation.  Référez-vous  à  “Renommer  une  diapositive”,  page  7 pour  plus
d’informations.

Copier et coller d’une présentation à une autre
1) Ouvrir les présentations (celles dans lesquelles vous voulez copier des diapositives et celle

dans laquelle vous voulez les coller).

2) Dans  une  présentation  où  vous  voulez  copier  des  diapositives,  sélectionnez  le  mode
Trieuse de diapositives en cliquant sur l’onglet de même nom, ou dans le menu principal
Affichage > Trieuse de diapos.

3) Sélectionnez  les  diapositives  désirées  et  choisissez  Édition  >  Copier dans  le  menu
principal, ou cliquez sur l’icône  Copier  de la barre d’outils standard, ou cliquez-droit
sur une des diapositives sélectionnées et choisissez Copier dans le menu contextuel, ou
encore utilisez la combinaison de touches Ctrl+C.

4) Basculez sur  la  présentation qui  doit  recevoir  les diapositives et  sélectionnez le  mode
Normal (par exemple, Affichage > Normal dans le menu principal).

5) Sélectionnez la  diapositive  à la  suite de laquelle  vous voulez  déposer  les  diapositives
copiées.

6) Sélectionnez Édition > Coller dans le menu principal, ou cliquez sur l’icône Coller  de
la  barre  d’outils  Standard,  ou  cliquez-droit  sur  une  des  diapositives  sélectionnées  et
choisissez Coller dans le menu contextuel, ou encore utilisez la combinaison de touches
Ctrl+V.

Glisser-déposer d’une présentation à une autre
1) Ouvrir les présentations (celle dans laquelle vous voulez copier des diapositives et celle

dans laquelle vous voulez les coller)  et organisez les fenêtres de manière à ce que les
deux présentations soient visibles.

2) Sélectionnez le mode Trieuse de diapositives dans chaque fenêtre.

3) Sélectionnez les diapositives à copier.

4) Pour déplacer les diapositives, cliquez et maintenez appuyé le bouton gauche de la souris
pour glisser-déposer les diapositives sélectionnées dans l’autre présentation.

5) Pour  copier les  diapositives,  maintenez  appuyée  la  touche  Ctrl,  cliquez  et  maintenez
l’appui  sur le  bouton  gauche  de  la  souris  pour  glisser-déposer  les  diapositives
sélectionnées dans l’autre présentation.
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Dupliquer une diapositive
Si vous désirez créer une diapositive qui hérite de tous les attributs d’une autre, dupliquez-la, puis
personnalisez-la. Pour dupliquer une diapositive :

1) Entrez dans le mode  Normal, soit en cliquant sur l’onglet  Normal, soit en sélectionnant
Affichage > Normal dans le menu principal.

2) Affichez la diapositive à dupliquer sur le volet Espace de travail.

3) Deux méthodes :

• Sélectionnez Insertion > Dupliquer la diapo dans le menu principal. La diapositive
dupliquée est insérée après l’original et affichée sur le volet Espace de travail.

• Dans  le  volet Diapos,  en  survolant  la  diapositive,  trois  icônes  sur  fond  noir
apparaissent, cliquez sur celle de droite pour dupliquer la diapositive.

Astuce
Lorsqu’une diapositive paraît  trop chargée pour  être  bien  comprise,  dupliquez-la,
puis répartissez les informations sur les deux, sans vous soucier des attributs de
présentation qui seront conservés.

Renommer une diapositive
Pour renommer une diapositive :

1) Choisissez une des méthodes suivantes :

• En mode Normal, dans le volet Diapos, ou dans l’espace de travail, cliquez-droit sur
la diapositive et choisissez Diapo > Renommer la diapo dans le menu contextuel.

• En  mode  Trieuse  de  diapositives,  cliquez-droit  sur  la  diapositive  et  sélectionnez
Renommer la diapo dans le menu contextuel.

2) Dans la boîte de dialogue Renommer la diapo (Figure 4), saisissez un nouveau nom pour
la diapositive et cliquez sur OK.

Figure 4 : Boîte de dialogue Renommer la diapo

Répartir les éléments d’une diapositive sur plusieurs autres
S’il y a trop d’éléments de plan, plutôt que de réduire la taille de la police, il vaut mieux subdiviser
la diapositive en deux ou plusieurs exemplaires.

Comme  dans  la  section  “Dupliquer  une  diapositive“,  page  7,  vous  pouvez  dupliquer  votre
diapositive et répartir manuellement les éléments. Si votre diapo est constituée d’un cadre de texte
créé par une mise en forme automatique, vous pouvez aussi la subdiviser de la manière suivante :

1) Dupliquez éventuellement la diapositive pour la restaurer en cas d’erreur.

2) Sélectionnez  Insertion > Diapo à partir du plan dans le menu principal pour créer une
nouvelle diapositive pour chaque niveau supérieur du plan. Le texte du niveau de plan
devient le titre de chaque diapositive. Chaque niveau inférieur de plan de la diapositive
originale est remonté dans les diapositives résultantes.
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3) Vous pouvez aussi exécuter l’étape 2 sur l’une ou l’autre des diapositives résultantes afin
de les subdiviser à leur tour.

La Figure 5 montre une diapositive dont le plan a été divisé avec la commande Diapo à partir du
plan. Chaque diapositive résultante a pris pour titre le texte du niveau de plan depuis lequel elle a
été créée.

Figure 5 : Diapositive 1 déployée en diapositives 2, 3 et 4.

Attention Pour que la commande Diapo à partir du plan fonctionne, la mise en page ne doit
contenir qu’un seul cadre de texte à mise en page automatique. Si la mise en page
de  la  diapositive  n’en  permet  pas  la  subdivision,  l’élément  du  menu  principal
correspondant à la commande sera grisé.

Résumer plusieurs diapositives en une seule
Vous pouvez regrouper des diapositives en une seule pour créer un résumé. Cette commande
peut servir à créer le programme de votre présentation.

1) En mode Normal, ou Trieuse de diapositives sélectionnez la diapositive qui doit apparaître
en premier.

2) Sélectionnez Insertion > Diapo de résumé pour créer une nouvelle diapositive (Figure 6)
à la fin de la présentation.  Le titre de chacune des diapositives de la présentation est
affiché dans une liste à puces sur cette dernière diapositive.

3) Bien sûr, vous pouvez déplacer cette diapositive où bon vous semble dans la présentation.
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Figure 6 : Diapositive résumé

Supprimer une diapositive
Pour supprimer une diapositive, utilisez une des méthodes suivantes :

• En  mode  Normal,  Plan ou  Trieuse  de  diapositives,  sélectionnez  une  diapositive,  puis
choisissez  Édition >  Supprimer  la  diapo dans  le  menu principal,  ou  appuyez  sur  la
touche Suppr.

• Dans le volet  Diapos sélectionnez une diapositive et cliquez-droit. Choisissez Supprimer
la diapo dans le menu contextuel, ou appuyez sur la touche Suppr.

• En mode Normal, cliquez-droit sur la diapositive dans l’espace de travail, puis sélectionnez
Diapo > Supprimer la diapo dans le menu contextuel.

Astuce

Lorsque vous travaillez en mode  Trieuse de diapositives (Affichage > Trieuse de
diapos), vous pouvez supprimer plusieurs diapositives simultanément. Sélectionnez-
les en les entourant avec la souris, ou avec des Ctrl+clic, et appuyez sur la touche
Suppr.

Créer des diapositives d’après un plan

Lorsque vous préparez une présentation, il peut être pratique de créer le plan avec LibreOffice
Writer. Une fois le plan élaboré, vous pouvez créer une ou plusieurs diapositives pour chacun des
plus hauts niveaux du plan avec l’une des méthodes suivantes :

• envoyer un plan de Writer à Impress pour créer une nouvelle présentation ;

• envoyer un résumé de Writer à Impress pour créer une nouvelle présentation ;

• copier et coller le plan de Writer vers Impress pour l’ajouter à une présentation ou à une
présentation vide nouvellement créée.

Utiliser un plan créé avec Writer
Le document de Writer doit contenir des titres formatés avec les styles de titre par défaut.

1) Sélectionnez Fichier > Envoyer > Plan vers présentation dans le  menu principal  de
Writer pour créer une nouvelle présentation avec les titres.

2) La nouvelle présentation s’ouvre dans Impress en mode Plan (Figure 7).

3) Cliquez sur l’onglet  Normal pour compléter les diapositives que vous voyez dans le volet
Diapos.
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Si certains niveaux de plan contiennent trop d’éléments pour une seule diapositive, référez-vous à
la section “Répartir les éléments d’une diapositive sur plusieurs autres“, page 7.

Figure 7 : Plan créé à partir d’un document Writer

Utiliser une auto-synthèse créée avec Writer
Le document de Writer doit contenir des titres formatés avec les styles de titre par défaut. Lorsque
vous  utilisez  l’Auto-synthèse pour  copier  un  document  dans  une  nouvelle  présentation,  vous
pouvez choisir le nombre de niveaux de plan ainsi que le nombre de paragraphes à afficher.

Figure 8 : Choisir les niveaux de plan pour l’auto-
synthèse

1) Sélectionnez Fichier  >  Envoyer  >  AutoSynthèse  vers  présentation dans  le  menu
principal de Writer pour ouvrir la boîte de dialogue Créer une AutoSynthèse (Figure 8).

2) Choisissez le nombre de niveaux de plan que vous voulez inclure dans la présentation
dans la liste déroulante Niveaux de plan à inclure. Par exemple, si vous choisissez quatre
niveaux, tous les paragraphes formatés avec les styles de Titre 1 à 4 seront inclus dans la
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présentation,  chacun  accompagné  du  nombre  de  paragraphes  spécifiés  dans
Paragraphes par niveau.

3) La nouvelle présentation s’ouvre dans Impress en mode Plan. Cliquez sur l’onglet Normal
pour compléter les diapositives que vous voyez dans le volet Diapos.

4) Si certains niveaux de plan contiennent trop d’éléments pour une seule diapositive, référez-
vous à la section “Répartir les éléments d’une diapositive sur plusieurs autres“, page 7.

Copier et coller un plan
Copiez et collez un plan dans une présentation existante de la manière suivante :

1) Saisissez le plan dans Writer, sélectionnez-le et choisissez Édition > Copier, ou cliquez-
droit sur le plan et choisissez Copier dans le menu contextuel.

2) Créez une nouvelle diapositive dans Impress, donnez-lui un titre, choisissez une mise en
page automatique avec une zone de texte.

3) Collez le plan créé avec Writer dans la zone texte de la diapositive. Ne vous inquiétez pas
si le texte ne correspond pas à l’espace disponible sur la diapositive.

4) Si le texte ne correspond pas à l’espace disponible sur la diapositive, subdivisez-la (voyez
la section “Répartir les éléments d’une diapositive sur plusieurs autres”, page 7).

5) Lors du collage, la structure hiérarchique du plan peut être perdue. Si besoin, rétablissez-la
à l’aide des boutons  de la  barre d’outils  Formatage du texte (Chapitre 3,
Ajouter et mettre en forme du texte).

Astuce
Il peut être utile d’ouvrir la fenêtre  Styles et formatage et son onglet des styles de
présentation pour corriger le niveau de chaque élément.

Modifier des diapositives

Utilisez les pages maîtresses pour donner à votre présentation un aspect plus professionnel et
aussi  pour  éviter  d’avoir  à  formater  manuellement  chaque  diapositive.  Dans  une  même
présentation, vous pouvez utiliser plusieurs pages maîtresses pour donner le même aspect à des
groupes de diapositives. Voyez le Chapitre 2, Utiliser des pages maîtresses, styles et modèles de
ce guide pour plus d’informations à ce sujet.

Formater la diapositive
Dans Impress, la boîte de dialogue Paramétrage de la page (Figure 9) peut servir à régler la mise
en page dans les modes : Normal, Notes ou Prospectus.

Note

Chaque changement dans le format de la page (taille, marges, orientation, etc.) est
effectué  sur  l’ensemble  des  diapositives  de  la  présentation.  Dans  Impress,  vous
pouvez définir  seulement un style de page, contrairement à Writer ou Calc, mais
vous  pouvez  modifier  l’arrière-plan,  diapositive  par  diapositive :  référez-vous  à
“Modifier l’arrière-plan d’une diapositive”, page 13.

Dans le mode Normal, sélectionnez Format > Page dans le menu principal, ou cliquez-droit sur la
diapositive et choisissez Diapo > Paramétrer la page dans le menu contextuel pour ouvrir la boîte
de dialogue Paramétrage de la page (Figure 9).
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Figure 9 : Boîte de dialogue Paramétrage de la page

L’onglet Page est divisé en trois sections : Format de papier, Marges, et Paramètres de mise en
page. La modification de ces paramètres affecte toutes les diapositives de la présentation.

Dans  la  section  Format  de  papier,  sélectionnez  dans  la  liste  déroulante  le  format  qui  vous
convient. Les dimensions changent automatiquement lorsqu’un format standard est choisi. La liste
déroulante contient des formats pour afficher les diapositives et d’autres pour les imprimer sur
papier.

La valeur par défaut est le format d’écran 4:3. Pour les écrans larges, vous devrez plutôt choisir le
format 16:9.

Dans  la  section  Marges,  modifiez  l’espace  entre  les  bords  de  la  page  et  le  contenu  de  la
diapositive.

Dans la section Paramètres de mise en page, sélectionnez le format de numérotation des pages
dans la liste déroulante Format. Pour permettre à la taille des objets et des polices de s’adapter
lors d’une modification du format de papier, cochez la case Adapter l’objet au format de papier.

Dans la section Format de papier,  vous pouvez aussi sélectionner l’orientation de la diapositive
ou du papier (portrait ou paysage) ainsi que le bac à papier à utiliser. Dans Impress, vous ne
pouvez sélectionner qu’un bac à papier pour l’impression de l’ensemble. Rien ne vous empêche
toutefois  d’utiliser  des  paramétrages  différents  pour  imprimer  les  notes  et  les  prospectus  en
modifiant le bac entre les séries d’impression : par exemple, pour imprimer les diapositives sur
transparents et les notes et prospectus sur des médias différents. Pour plus d’informations sur
l’impression des présentations, référez-vous au  Chapitre 10, Imprimer, envoyer, et sauvegarder
des diaporamas de ce guide.

Choisir une page maîtresse
Dans le volet Tâches, sélectionnez l’onglet Pages maîtresses. Pour appliquer un des masques de
diapos à toutes les diapositives de votre présentation, cliquez sur lui dans la liste.

Pour appliquer un masque différent à une ou plusieurs diapositives sélectionnées :

1) Dans le volet Diapos ou la Trieuse de diapositives, sélectionnez les diapositives que vous
voulez modifier.
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2) Dans le volet Tâches, cliquez-droit sur le masque de diapos que vous voulez appliquer aux
diapositives  sélectionnées et  choisissez  Appliquer  aux diapos sélectionnées dans le
menu contextuel.

Le  Chapitre 2, Utiliser des pages maîtresses, styles et modèles de ce guide traite en détail des
pages maîtresses (aussi nommées masques de diapos).

Modifier l’arrière-plan d’une diapositive
Cette section traite de la modification de l’arrière-plan d’une diapositive.

Astuce
Pour faciliter la maintenance, il est recommandé de créer des masques de diapos
supplémentaires plutôt que de modifier directement quelques diapositives.

Note
Appliquer un arrière-plan à des diapositives individuelles se fait de la même manière
que le remplissage d’une forme. Voyez le  Chapitre 6, Mettre en forme des objets
graphiques pour de plus amples informations.

Pour modifier l’arrière-plan d’une diapositive :

1) En mode Normal, sélectionnez la diapositive à modifier.

2) Sélectionnez Format > Page dans le menu principal, ou cliquez-droit sur la diapositive et
choisissez Diapo > Paramétrer la page dans le menu contextuel pour ouvrir la boîte de
dialogue Paramétrage de la page (Figure 9). Cliquez sur l’onglet Arrière-plan.

3) Suivez les instructions de la section Formater la zone de remplissage du Chapitre 6, Mettre
en forme des objets graphiques de ce guide.

4) Cliquez sur OK pour enregistrer les modifications.  Impress vous demande si vous voulez
appliquer  la  modification  à toutes  les  pages.  Pour  modifier  seulement  la  diapositive
sélectionnée, cliquez sur  Non.  Si vous cliquez sur  Oui,  Impress va appliquer le nouvel
arrière-plan à toutes les diapositives de la présentation.

Choisir une mise en page de diapositive
Après avoir créé une nouvelle diapositive, vous devez choisir la mise en page automatique qui
convient  le  mieux  au  contenu  que  vous  allez  saisir.  Impress  vous  propose  quelques  types
prédéfinis de mises en page pour vos diapositives (Figure 10).

Pour appliquer une mise en page automatique à une diapositive :

1) Dans le volet  Tâches, sélectionnez  Mises en page afin d’afficher les différents modèles
prédéfinis.  Si le volet  Tâches n’est pas affiché, sélectionnez  Affichage > Volet Tâches
dans le menu principal.

2) Déplacez le pointeur de la souris sur les différentes vignettes pour obtenir une infobulle
résumant les objets présents dans chaque mise en page (attention, la case infoballons ne
doit pas être cochée dans Outils > Options > LibreOffice > Général du menu principal).

3) Cliquez sur la mise en page automatique choisie pour l’appliquer à la diapositive.
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Figure 10 : Section Mises en pages

Note

Si  la  mise  en  page est  changée alors  que la  diapositive  contient  des  données,
Impress n’effacera pas le contenu, mais le repositionnera en fonction de la mise en
page choisie. Cela peut aboutir à des chevauchements ou à des débordements de
données.

Toutes les techniques de travail sur les cadres de texte traitées dans le  Chapitre 3, Ajouter et
mettre en forme du texte de ce guide peuvent être appliquées au titre et aux éléments des cadres
de texte à mise en page automatique de la diapositive. L’espace réservé aux images peut être
déplacé et  redimensionné,  voyez le  Chapitre 4,  Ajouter et mettre en forme des images de ce
guide. Le Chapitre 7, Ajouter des feuilles de calcul, graphiques et autres objets de ce guide montre
comment ajouter et modifier d’autres objets.

Ajouter des commentaires

Lorsque vous créez une présentation dans un groupe de travail collaboratif,  il est  très pratique
d’insérer des commentaires pour l’information des autres membres du groupe.

Pour ajouter un commentaire, passez en mode  Normal et sélectionnez la diapositive que vous
voulez commenter. Sélectionnez Insertion > Commentaire dans le menu principal pour afficher la
boîte commentaire (Figure 11) dans le coin haut gauche de la diapositive. Lorsque vous avez fini
de saisir votre commentaire, vous pouvez fermer la boîte en cliquant à l’extérieur de celle-ci.

Figure 11 : Ajouter un commentaire
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Chaque commentaire est coloré, marqué des initiales de son auteur et d’un numéro de séquence,
il est affiché dans le coin haut gauche de la diapositive dans le mode Normal. Cliquez sur cette
boîte pour afficher le texte du commentaire. La taille de la boîte est fixe et des barres de défilement
apparaissent si nécessaire.

Vous pouvez également accrocher votre commentaire à un objet particulier de la présentation :

1) après avoir tapé votre commentaire, cliquez à l’extérieur du commentaire ; celui-ci se réduit
à un petit carré de couleur ;

2) cliquez sur ce carré et déplacez-le sur l’objet ou placement précis auquel se réfère votre
commentaire.

Éditer, supprimer et répondre aux commentaires
Vous pouvez seulement éditer les commentaires que vous avez vous-même créés. Vous pouvez
répondre au commentaire d’une autre personne : cliquez sur la petite flèche noire en bas à droite
du commentaire, et choisissez Répondre dans la liste déroulante (Figure 12).

Figure 12 : Liste déroulante d'un commentaire

Un jeu limité d’options permet de formater le commentaire. Cliquez-droit sur la boîte, et sélection-
nez les attributs qui vous conviennent (gras, italique, souligné, barré) dans la liste déroulante ou
collez le contenu du presse-papier.

Utilisez  la  liste  déroulante  de  commentaire  (Figure  12)  pour  effacer  le  commentaire  courant,
supprimer  tous  les  commentaires  de  l’auteur,  ou  supprimer  tous  les  commentaires  de  la
présentation.  Si  le  commentaire  que  vous  ouvrez  a  été  créé  par  une  autre  personne,  vous
trouverez aussi l’option Répondre dans la liste déroulante.

Ajouter et formater des notes

Le mode  Notes permet d’ajouter des informations aux diapositives dans une présentation. Les
Notes ne sont pas affichées pendant le déroulement du diaporama. Cependant, en utilisant deux
moniteurs,  vous  pouvez  afficher  les  notes  sur  le  second  moniteur  et  ainsi  l’utiliser  comme
prompteur. Vous pouvez aussi imprimer les notes et les utiliser comme aide-mémoire pendant la
présentation.

Note

Si vous présentez régulièrement des diaporamas en public à  l’aide d’un projecteur,
vous serez sans doute intéressé par Presenter  Console,  une extension qui  vous
permet  d’afficher  sur  votre  écran  les  notes,  la  diapositive  suivante  et  d’autres
informations  utiles,  tandis  que seule  la  diapositive  est  montrée par  le  projecteur.
Cette extension est installée par défaut avec LibreOffice.

Ajouter des notes à une diapositive
Pour ajouter des notes à une diapositive :

1) Sélectionnez dans le volet Diapos la diapositive à laquelle vous voulez ajouter des notes.

2) Passez  dans  le  mode  Notes (Figure  13)  en  cliquant  sur  l’onglet  Notes dans  le  volet
Espace de travail, ou sélectionnez Affichage > Page de notes dans le menu principal.
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3) Cliquez dans le cadre de texte affichant  Cliquez pour ajouter des notes et saisissez ou
collez votre texte ou vos images.

4) Pour ajouter des notes à une autre diapositive, répétez les étapes 1 et 3.

5) Lorsque vous en avez terminé avec les notes, repassez en mode Normal.

Figure 13 : Mode Notes

Formater des notes
Il est fortement recommandé d’utiliser le Masque des notes et le style de présentation Notes pour
formater l’aspect des notes, plutôt que de les formater pour chaque diapositive.

Tous les conseils de formatage donnés dans cette section concernent aussi bien le Masque des
notes que le style de présentation Notes.

Pour ouvrir le Masque des notes, choisissez Affichage > Masque > Masque des notes dans le
menu principal (Figure 14).

Figure 14 : Mise en page du Masque de notes
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Formater la page des Notes
Pour formater la page des notes :

1) Passez dans le mode Notes en cliquant sur l’onglet Notes dans le volet Espace de travail,
ou sélectionnez Affichage > Page de notes dans le menu principal.

2) Sélectionnez Format > Page dans le menu principal, ou cliquez-droit et choisissez Diapo
> Paramétrer la page pour ouvrir la boîte de dialogue Paramétrage de la page (Figure
15).

3) Définissez les paramètres désirés. La boîte de dialogue Paramétrage de la page pour les
notes est la même que pour les diapositives. Voyez Formater la diapositive, page 11 pour
la description de cette boîte. La seule différence est que pour la page Notes, la valeur par
défaut de l’orientation est Portrait et le format A4.

4) Lorsque vous avez terminé, cliquez sur OK pour fermer la boîte de dialogue.

Figure 15 : Paramétrage de la page pour les Notes

Paramétrer la mise en page automatique
Dans le mode Notes, Impress crée quatre zones pour saisir des informations sur la présentation :

• la zone d’en-tête,

• la zone de date,

• la zone de pied de page,

• la zone de numéro de page.

Pour personnaliser ces champs, procédez comme suit :

1) Passez dans le mode Notes en cliquant sur l’onglet Notes dans le volet Espace de travail,
ou  sélectionnez  Affichage  >  Page  de  notes dans  le  menu  principal.  Vous  pouvez
également passer par le masque des notes en choisissant Affichage > Masque > Masque
des notes (Figure 14) dans le menu principal.

2) Cette personnalisation se fait à l’aide de la  boîte de dialogue  En-tête et pied de page
(Figure 16). Pour  l’afficher, vous disposez,  au choix,  des commandes suivantes dans le
menu principal :

• Affichage > En-tête et pied de page
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• Insertion > Date et heure

• Insertion > Numéro de page

3) Date et heure :  Cliquez sur l’onglet  Notes et prospectus.  Choisissez entre  Fixe (saisir
alors la date et l’heure à afficher) ou Variable pour entrer la date et l’heure de création de
la diapositive. Dans le second cas, utilisez les deux menus déroulants pour définir le format
de la date et la langue.

4) Numéro de page,  En-tête et pied de page :  Cliquez sur l’onglet  Notes et prospectus.
Cochez les cases pour activer les zones correspondantes.  Pour l’en-tête et  le  pied de
page,  saisissez le texte dans les champs correspondants. Pour le numéro de page, le
formatage est défini dans la section “Formater la page des Notes”, page 17.

5) Cliquez sur le bouton Appliquer partout pour enregistrer ces paramètres et fermer la boîte
de dialogue.

Figure 16 : Boîte de dialogue En-tête et pied de page

Formatage du texte
Lorsque le  texte est  inséré dans la  zone Notes,  il  est  automatiquement formaté avec le  style
prédéfini Notes qui fait partie des styles de présentation. Le meilleur moyen de formater les notes
est donc de modifier ce style selon vos besoins. Référez-vous au Chapitre 2, Utiliser des pages
maîtresses, styles et modèles de ce guide pour de plus amples informations.

Si un formatage manuel est requis, par exemple pour mettre en évidence une section particulière,
référez-vous au Chapitre 3, Ajouter et mettre en forme du texte de ce guide.

Formatage avancé du texte
Vous pouvez appliquer d’autres changements aux pages Notes, par exemple :

• déplacer le texte et la diapositive dans la page ;

• redimensionner  l’image  de  la  diapositive  et  le  cadre  de  texte  (uniquement  depuis  le
Masque des notes pour la diapositive) ;

• ajouter d’autres objets (cadre de texte, image, forme, etc.) sur la page.

Imprimer les notes
1) Sélectionnez Fichier > Imprimer dans le menu principal.

2) Dans  la  section  Imprimer (Figure  17)  de  l’onglet  Général de  la  boîte  de  dialogue
Imprimer, sélectionnez Notes dans la liste déroulante Document.
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3) Faites éventuellement d’autres modifications et cliquez sur OK pour imprimer.

Pour de plus amples informations sur l’impression des diapos, des notes et des prospectus, voyez
le Chapitre 10, Imprimer, envoyer, et sauvegarder des diaporamas de ce guide.

Figure 17 : Boîte de dialogue Imprimer

Exporter les notes en PDF
1) Choisissez Fichier > Exporter au format PDF dans le menu principal.

2) Dans la boîte de dialogue Options PDF (Figure 18), cliquez sur l’onglet Général.

3) Vérifiez que la case Exporter les pages de notes est cochée et cliquez sur Exporter.

4) Dans la boîte de dialogue Exporter, entrez un nom de fichier, sélectionnez le dossier de
destination et cliquez sur le bouton Enregistrer.

Figure 18 : Boîte de dialogue Options PDF

Note
Si votre présentation contient 10 diapositives, le PDF contiendra 20 pages : 10 pages
de diapositives, suivies de 10 pages de notes formatées pour le papier. Il n’est pas
possible de créer uniquement les pages de notes.
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Créer des prospectus

Un Prospectus est une vue particulière de la présentation faite pour être imprimée et distribuée à
l’assistance.  Chaque  page  du  prospectus  contient  de  une  à  neuf  vignettes  montrant  les
diapositives de la présentation et permet de suivre la présentation et de l’utiliser comme référence.
Cette section explique comment personnaliser la page prospectus.

Notez que la vue Prospectus consiste en une seule page quel que soit le nombre de diapositives
de la présentation et le nombre de pages qui seront imprimées.

Modifier la mise en page

Figure 19 : Exemple de prospectus avec six vignettes de 
diapositives

Lorsque vous créez des prospectus, choisissez d’abord le nombre de vignettes de diapositives que
vous voulez imprimer sur chaque page.

1) Passez en mode  Prospectus,  en  cliquant  sur  l’onglet  Prospectus du  volet  Espace de
travail,  ou  en  sélectionnant  Affichage > Page de prospectus dans  le  menu principal
(Figure 19).

2) Si le volet  Tâches n’est pas affiché, choisissez  Affichage > Volet tâches dans le menu
principal.

3) Dans le volet Tâches, sélectionnez la section Mises en page (Figure 20).

4) Sélectionnez la mise en page que vous préférez, l’espace de travail change aussitôt pour
refléter votre choix.

Figure 20 : Mises en pages pour Prospectus
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Formater les prospectus
Vous pouvez formater divers aspects du prospectus, depuis le style de la page jusqu’aux éléments
qui  s’affichent  sur  la  page.  Vous ne pouvez pas formater  individuellement  les pages :  chaque
changement s’appliquera à l’ensemble du prospectus.

Formater la page
Pour formater les pages de prospectus :

1) Passez en mode  Prospectus,  en  cliquant  sur  l’onglet  Prospectus du  volet  Espace de
travail, ou en sélectionnant Affichage > Page de prospectus dans le menu principal.

2) Sélectionnez Format > Page dans le menu principal, ou cliquez-droit et choisissez Diapo
> Paramétrer la page dans le menu contextuel.

3) Dans la boîte de dialogue  Paramétrage de la page (Figure 15), définissez le format du
papier, son orientation (portrait ou paysage), les marges, etc. Cliquez sur OK.

Paramétrer les options de mise en page automatique
Dans  le  mode  Prospectus,  Impress  crée  quatre  zones  pour  saisir  des  informations  sur  la
présentation :

• la zone d’en-tête,

• la zone de date,

• la zone de pied de page,

• la zone de numéro de page.

Note
Les données entrées ne  sont  pas  visibles  en mode  Prospectus, elles apparaîtront
seulement sur les pages imprimées.

La méthode pour accéder à ces zones et les paramétrer est la même que pour les Notes, et utilise
la même boîte de dialogue : référez-vous à la section “Paramétrer la mise en page automatique”,
page 17.

Déplacer les vignettes et ajouter des images
Vous pouvez déplacer  et redimensionner tous les éléments de ces prospectus et même ajouter
des éléments graphiques. Voyez le  Chapitre 5, Gestion des objets graphiques de ce guide pour
l’utilisation des outils  graphiques.  Pour  modifier  la  taille d’une vignette de diapositive,  vous ne
pouvez le faire que par l’intermédiaire de la boite de dialogue Position et taille (menu Format >
Position et taille ou raccourci clavier F4).

Astuce
Après  avoir  dessiné  un  prospectus,  vous  pouvez  souhaiter  l’enregistrer  comme
modèle afin de le réutiliser. Pour cela, voyez la section “Travailler avec des modèles”
du Chapitre 2, Utiliser des pages maîtresses, styles et modèles.

Attention Si  vous cliquez sur  l’une des autres  mises  en page de prospectus et  que vous
revenez  à  la  précédente,  les  vignettes  de  diapositives  reprennent  leur  position
d’origine  alors que les  éléments  graphiques que vous avez ajoutés  ne  sont  pas
affectés. Il vous faudra déplacer à nouveau les vignettes.
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Imprimer les prospectus

Figure 21 : Choisir les diapositives à imprimer dans 
le Prospectus

1) Sélectionnez Fichier > Imprimer dans le menu principal.

2) Dans  la  section  Imprimer (Figure  21)  de  l’onglet  Général de  la  boîte  de  dialogue
Imprimer, et la liste déroulante Document, sélectionnez Prospectus.

3) Indiquez le nombre de diapositives par page et l’ordre dans lequel elles seront imprimées.
Si  vous  laissez  le  nombre  de  diapositives  par  page  à  Par  défaut,  la  mise  en  page
personnalisée sera appliquée. Si vous modifiez ce nombre, la mise en page par défaut
sera appliquée, mais les objets supplémentaires seront imprimés.

4) Pour choisir les diapositives à inclure dans les prospectus, cochez Diapos et spécifiez les
numéros de diapositives, dans la section Plage et exemplaires de l’onglet Général.

Pour de plus amples informations sur l’impression des diapos, des notes et des prospectus, voyez
le Chapitre 10, Imprimer, envoyer, et sauvegarder des diaporamas de ce guide.

Exporter les prospectus en PDF
Cette version de LibreOffice  ne permet pas  d’exporter les prospectus en PDF. Si vous essayez,
vous obtiendrez uniquement l’impression des diapositives (une par page). Il existe cependant des
logiciels d’impression virtuelle qui produisent un fichier PDF à la place du papier.
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